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HAVE FUN WITH 
COMPUTER GRAPHICS 

 
Come have fun drawing computer illustrations using Microsoft Word's Draw 

function.  We will work with shapes, lines, "textures", copying and pasting, moving, 
saving, edit points, etc.   These computer braille graphics use the TIE (Tactile Image 
Enhancer).  Bring your laptop and join in the fun.    

Some of my suggestions differ from my previous "Can't Draw? Use Computer 
Graphics!" workshop because of further research and consultation with graphics 
experts.  Lead lines are dashed instead of solid, etc.   

 

BASIC GRAPHIC RULES 
 

Before using the computer and/or scanner to produce braille graphics, learn 
some basic graphic rules and hints. 

Some graphics are more suited to collage or foil production.  Early grades, 
anatomy, etc. where differences between texture, location, size, etc. is important are 
better suited to collage or foil.  Shells would be better done in foil so that you could feel 
each indentation and curve to differentiate between shells.  Computer graphics do not 
represent 3-D effects well.  Using overlapping sequins to replicate fish scales feels more 
truer to life than drawn individual scales. 

Remember also that some illustrations simply should not or cannot be 
reproduced.  If the information is already stated in the text, don't reproduce the graphic 
unless the teacher desires it or unless reading graphics is being taught such as in a test 
or a class teaching graphs, charts, maps, and so on.  Some illustrations are too detailed 
or confusing that they cannot be simplified or reproduced even using more than one 
braille page. 

3-D illustrations should be reproduced in 2-D instead.  Usually you could just 
show the side view.  If you need to show something like a cube, show it in 3-D.  Inside 
lines should be dashed.  You could also show it opened up like an unfolded carton.     

Graphics should be orientated toward the left side of the paper instead of 
centered.  This allows the reader to find it easier and to allow labels on the right side. 
Computer graphics are produced in layers.  Use Order on the Draw Menu if your layers 
get confused.  Try to figure out which layer goes first before starting. 

No Fill means that the shape is transparent so that you can see the  graphic 
layer(s) beneath the one marked No Fill.   

 

NOTE 
 
These instructions are for graphics embossed on the ViewPlus "Tiger" embosser.  If you 
need your graphic to be produced using the microcapsule "puff" paper, change the 
margins to left: 1.0, top: 0.6, and bottom and right: 0.5.  The font should be Braille 
Puffdots size 24.  The line spacing should be exactly 26 pt.  See the appendices for 
other font suggestions.   
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THANKS 
 
Guidelines for Mathematical Diagrams, and its supplement, published by BANA (Braille 
Authority of North America), is one of the best places to start.  Another is the Tactile 
Graphics Guidebook by APH (American Printing House).  Both have critiqued examples 
along with basic suggestions and explanations.  They explain placement, labeling, etc. 
 
Ruth Jean Ostle's VAVF (Visual Aid Volunteers of Florida, Inc.) Conference workshops 
are invaluable in learning what to include or not include, how to arrange it, how to label 
the graphic, etc.   
 
Much of this manual comes from Doris and Pete Schuyler's computer graphics 
workshops at past VAVF Conferences.  Part of the scanning section comes from Janet 
Nullet's scanning workshops.   
 
Thank goodness Pat Gray shares any new computer and graphic information she 
discovers since I use much of the same information with as she does with her maps. 
 
The information about the Braille29 font was from "Tiger Tactiles Using Microsoft Word" 
at the 2009 California Conference.  It was presented by Peggy Schuetz and Bob 
Walling from the Transcribing Mariners, and Art Benitez from American Braille. 
 
NBA (National Braille Authority, Inc.) has numerous workshop publications about 
producing different types of braille graphics.  These publications can be purchased 
directly from NBA. 
 
Some of the information in this manual is based on and developed from information 
published in the LTS Online Help Collection (www.uwec.edu/help) developed by the 
University of Wisconsin-Eau Claire and copyrighted by the University of Wisconsin 
Board of Regents. Used by permission.  www.uwec.edu/Help/Office03 and 
www.uwec.edu/Help/Office07. 
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 PRINTER SETUP 
OF GRAPHIC PAGES 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you do not have a large carriage printer, see if you can install the HP 9800 
printer on the included CD.  If not, try to download the driver from the internet 
from the HP website. 
 

If you do have a large carriage printer, make the following changes: 
 
1.  Click on File/Print  so you can change the Printer Name:  (name of your printer).  

Mine is the hp deskjet 9800 series. 
 
2.  Click on Properties. 
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CHANGING PRINTER PROPERTIES 
TO 11.5 X 11 INCH SIZE 

 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  My large carriage printer allows me to set up a QuickSet Name so that all I have to 

do is choose that name when I begin working on a new graphics page and the 
printer is set to 11.5 x 11 inch paper without me going through all the steps each 
time.  Some printers use the name "Custom" or something similar. 

 
2.  Type another name for the QuickSet name:  Braille Graphic Page 11.5 x 11. 
 
3.  Save the new QuickSet name by clicking on the Save button in the red box to the 

right of the name. 
 
3.  See the size in the red box?  It needs to be changed to 11.5 x 11 inches. 
 
4.  Click on Custom button.  This will bring up another menu. 
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CHANGING THE CUSTOM SIZE 
TO 11.5 x 11 INCHES 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  Type in the new measurements of Width: 11.5 and Length (or Height): 11. 
 
2.  Notice the Custom in the red box.  You cannot change this name for this printer.  

Each time you change the Custom, the name will change from Custom1 to Custom 
2, etc. automatically.  Don't worry about this. 

 
3.  Click OK on the Custom Paper Size menu. 
 
4.  Make sure the size changed on the Properties menu before clicking this OK. 
 
5.  Do Not Click on OK again.  You will print an empty sheet.  Click on Close instead. 
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PRINT SCREEN TO SEE WHAT YOU HAVE 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  See the red box around the page with a magnifier icon?  The red box is around the 

Print Preview icon.  You can click on it to see what your whole page looks like or 
maybe two consecutive pages look like.  (Not the page with the turned corner 
without the red box.  That one is the New Page icon.) 

 
2.  See the 25% in the red box?  You can change the size of the image of the page 

here.  25% usually lets you see 2-3 pages at a time.   
 
3.  Only put one graphic to a file unless it will take more than one page to complete the 

whole graphic with its key, if any.  When you make adjustments to the first graphic, 
you will not inadvertently mess up the next.  Make sure your filename has the 
consecutive page number—265, 265A for a265, 265B for b265— in the filename, 
but use 265A, etc. to keep the pages in order.    786B Women in the Workforce bar 
graph would be a good name for the bar graph on page b786 entitled Women in the 
Workforce containing a bar graph and would be put into a folder named after the title 
of the book the graph was in. 

 
4.  Press the Esc key (Escape key) to toggle back to your regular page. 

 

 

8 x 11 
inches 

 

11.5 x 11 
inches 
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MAKING A MICROSOFT WORD 
GRAPHIC TEMPLATE 

 
1.File / Page Setup / Paper Size / Width:  11.5”  Height: 11” 
 
2. File / Margins / Orientation Portrait 
 
2.  File / Page Setup / Margins / Top, Bottom & Left: 1”, Right: 0.5” 
 

3.  Format / Font / Braille29 ,braille29 ,  (For ViewPlus embosser, font 

size 29.  You manually type the font size as 29.  It is not a choice.  Hit ENTER or it 
will not work!) 

 
4.  Format / Paragraph / Line Spacing: Exactly at 25  
 
5.  Make sure you have your ruler across the top and sides of your screen.  To add the 

ruler, go to View and click Ruler.   You may have to do it twice to get both top and 
side rulers. 

 
6.  Draw a line.  Change it to 2.5 or 3 points. 
 
7,  Draw / Set AutoShape default 
 
8.  Draw an arrow.  Change it to 2.5 or 3 points.  Choose either largest closed 3-point or 

open 3-point style. 
 
9.  Draw / Set AutoShape default 
 
10.  Delete line and arrow 
 
11.  Save as / Save As Type: Template (.dot).  Filename:  either Tiger Graphic Page 

11.5 x 11 or Puff Microcapsule 11.5 x 11 depending on which font  and font size you 
use.  If you can't get this to work, just Save As a Word 1997-2003 Document.   

 
12.  IMPORTANT!  Close file before using it!    
 
13.  File / New / Graphic Page to use it AFTER saving it under a different name. 
 
14.  When you go to emboss, make sure your embosser and file are both set to 

the 11.5 x 11" portrait oriented braille page or text and/or part of the graphic 
will be lost. 

 
** Always save your graphic files under the Word 1997-2003 Document format 
because some of the later versions of Word do not have all of the draw 
commands that are needed.  ** 
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SETTING MARGINS 

 
 

 
 

 
 
 

 
 

 
1.  Open Microsoft Word. 
 
2.  Click on File/Page Setup to get the Page Setup menu above. 
 
3.  Click on the Margins tab and change the Right Margin to .5 (that's point 5). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 For Puff Microcapsule Paper 
1.  Open Microsoft Word 2000. 
 
2.  Click on File/Page Setup to get the Page Setup menu above. 
 
3.  Click on the Margins tab and change the Right Margin to 0.5 (that's point 5). 
 
OR  
 
 For Tiger Embossed Graphics 
1. Open Word 2007. 
 
2.Click on Page Layout tab and choose Margins:  Left 1, Top 0.6, Bottom and Right 0.5. 
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SETTING PAGE SIZE 
IF YOU DO NOT HAVE A 

LARGE CARRIAGE PRINTER 
 

 
 
 

 
 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.  Click on Paper Size tab. 
 
2.  Click on the down arrow besides the Paper Size: Letter size and you will see the 

Tabloid (11 x 17 in.)  Notice Width is 11 and the Height is 17 and Orientation is 
marked Portrait. 

 
3.  Click on Orientation:  Landscape.  Notice that now the Width is 17, Height is 11, and 

Orientation is Landscape.  Width is always given first--Braille paper is 11.5 x 11". 
 
4.  Now click OK to set the changes on both the Margins and Paper Size tabs at one 

time. 
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SETTING PAGE SIZE 
IF YOU DO HAVE A 

LARGE CARRIAGE PRINTER  
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  Click on Paper Size tab. 
 
2.  Click on the down arrow besides the Paper Size: Letter size and you will see the 

Custom size choice.  Click on Custom size.  Notice Width is 8.5 and the Height is 11 
and Orientation is marked Portrait. 

 
3.  Change the margins to Width: 11.5, Height: 11, and leave Orientation: Portrait. See 

above. 
 
4.  Now click OK to set the changes on both the Margins and Paper Size tabs at one 

time. 
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MOVING IN MICROSOFT WORD 
 
Ctrl-a means hold down the Ctrl (Control) key while pressing the letter a key. 
Shift-F3 means hold down the Shift key while pressing the F3 (Function 3) key. 
 
End moves the cursor to the end of the line. 
Ctrl-End moves the cursor to the end of the file. 
Home moves the cursor to the first of the line. 
Ctrl-Home moves the cursor to the first of the file. 
 
Directional Arrows are the 4 keys that point in up, down, left, and right.  They move 

space by space in whichever direction that arrow points. 
Ctrl-Right Directional Arrow moves the cursor right one word at a time. 
Ctrl-Left Directional Arrow moves the cursor left one word at a time. 
Ctrl-Up or Ctrl-Down Directional Arrows move the cursor up or down one line at a 

time. 
 
Shift-Left and Right Directional Arrows highlights one space or cell in whichever 

direction the arrow is pointing. 
Shift-Up and Down Directional Arrows highlights one line from the cursor in 

whichever direction the arrow is pointing. 
Shift-End highlights from wherever the cursor was last clicked to the end of the line. 
Ctrl-Shift-End highlights from the cursor to the end of the file. 
Shift-Home highlights from the cursor to the first of the line. 
Ctrl-Shift-Home highlights from the cursor to the first of the file. 
 
Ctrl-a highlights all of the file.   
 
Ctrl-c copies whatever is highlighted to the clipboard. 
Ctrl-v pastes or moves the highlighted text from the clipboard to wherever you clicked 

your cursor last. 
Ctrl-x cuts the highlighted text.  Pressing the Delete key does the same. 
 
 Ctrl-d duplicates whatever line, shape, etc. that is "active" (Small squares show at 

each corner and middle of each side.) 
 
Delete key deletes one space or cell at a time from the right. 
Backspace key deletes one space or cell at a time to the left. 
 
Ctrl-p sends the file to the printer usually. 
 
Shift-F3 changes highlighted text from no capitalization, to all letters capitalized, to only 

the first letter in the word(s) capitalized continuously as long as you press Shift-F3.  
This one does not work in Braille2000. 
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Original location 
 
 

Can hardly see the difference.  Nudged one pixel using 
Ctrl plus the Right Directional Arrow.  Can also use 
Draw / Nudge / direction. 
 
Moved 3 pixels using Ctrl plus the Right Directional 

Arrow.  Still can hardly see change. 

Moved 5 pixels by pressing the Right Directional Arrow. 

MOVING AROUND 
LINES, AUTOSHAPES, AND TEXTBOXES  

 
Your line, AutoShape, or textbox must be selected (show with small squares around its 
perimeter) before you can move it or cause any change. 
 
                  
 
 
 
 
 
 
                  
                  
 
 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Dragged here. 

Dragged here. 
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Overlapping 

ORDER 
 
 
 
 
 
 
 
 
 

 

Rectangle Brought 
Forward Once 

Rectangle Brought 
Forward Twice 

Rectangle Brought  
To Front 

Circle Brought 
Forward Once 

Circle Brought 
Forward Twice 

Nothing happened Brought to Front  
works quicker. 
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DRAW TOOLBAR 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click on the Customize Quick Access Toolbar icon and choose Show Below Ribbon. 
2. Click on Customize … again and choose More Commands. 
3. Change Choose Commands From to All Commands. 
4.  Add the following to the toolbar:  Align     , Bring to Front, Draw Textbox, Edit Points, 

Group     , Print Preview, Redo, Rotate, Save, Select Drawing Objects, Send to 
Back, Shapes     , Undo, and Zoom.  These are alphabetical in the listing.  You can 
change the order later by dragging and dropping in the list to the right.  Don’t forget 
to OK. 

5.  Now you have your Draw Toolbar to use. 
. 

Check this to 
add and delete 
command icons 
from your Draw 
Toolbar and to 
move it below 
or above the 
ribbon 
 
 

These are all Draw 
command icons.  
You will not need 
all of them.  See 
below for a list of 
the basic ones. 
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DISTANCES AND LENGTHS AND SIZE 
 

Margins 
 

Margins should be 1" on the left, top, and bottom and 1/2" on the right.  FIMC prefers 1" 
on most sides for ease of copying, especially thermoform.  It's easier to use the same 
margins for everything instead of switching back and forth. 

 
Braille Cells 

 
Braille cells are approximately 1/4" high and 1/8" wide.  Spaces between braille cells are 
approximately 3/32".  Space between lines is about 5/32". 
 

Lines 
 
Primary lines (most important lines) should be roughest (jagged, dashed, etc.)  These 
should be at least 1/2" long.  Each dash of a dashed line should be between 1/4—3/8" 
long with the spaces between dashes 1/8—3/16". 
 
Secondary lines should be smoother. 
 
Line segments should be at least 1/2" long.  (Longer for coarser lines) 
 
Secondary lines such as graph tick marks, clock face indicator marks, number lines, 
dashes, etc.  should be 1/2" long split with 1/4" on each side. 
 
Two lines should be at least 3/32" or 3 mm apart.  This is the difference between two 
adjoining braille cells. 
 
Grid lines should be lightest in the graphic except for lead lines.  They should be at least 
3/8" apart. 
 
Lead lines (lines leading from the label to the diagram) should be used only when 
absolutely necessary.  Try to put your labels on or close by whatever they label. 
 

Point Symbols 
 

Points (oversized dots or shapes) should be at least 1/4" in diameter. 
 
Hollow point symbols are better than solid. 
 
Circles and squares are the easiest points to recognize. 
 
If needed, use hollow circles, squares, etc. as points on lines in line graphs.  Solid 
points cause problems with copying and they're harder to differentiate. 
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FONTS FOR PUFF MICROCAPSULE PAPER 
 
If you are using a regular or large carriage print embosser, you will need the Braille2000 
PuffDots font.  If you have the Braille2000 program, you have the BraillePuffDots font.  
Otherwise, download the Braille2000 program from http://www.c-a-s.com/brl2000.  
Unless you have the launch USB device, you can only run the program in demo mode 
and not save your file.  The font is installed on your computer automatically. 
 
You can also use Duxbury braille font.  See Appendices. 
 
If you have a ViewPlus embosser, you need to use the Braille29 or Brl29 font.  
Download the font from AmericanBraille.com > tools to your Desktop.  Then open the 
Control Panel > Fonts.  Now click on Start > Control Panel > fonts.  Drag and drop the 
font into the fonts folder and you are ready.  You can also download it from the CD 
given you at this workshop.  It will be in braille in the font list with dropped number 29. 

 
 

TEXTBOX INFORMATION 
 

Labels in text boxes are always horizontal, never vertical or slanted. 
 
If you can fit the full label on the part of the graphic to which it refers, use the full 

name.  If you cannot fit the full name, use abbreviations and a key. 
 
Lead lines from the label to the graphic component can be straight horizontal, 

vertical, or slanted lines. 
 
Most text boxes should have No Fill and No Line. 
 
Text boxes with No Fill and No Line can overlap as long as you keep your braille 

text separated enough. 
 
If your text box is on textured background, you will need a white colored fill to 

block the texture so that the print braille dots can be seen.  There should be at least 1/8" 
open area around the text in a textbox and the black line around the textbox itself. 

 
If your text box is on textured background, you will need a black border around 

the text so that the text box stands out. 
 
Text boxes do not need to be in the exact place on your graphic as it is in print.  

Sometimes the text will not fit in that space. 
 
Text box labels may need lead lines to point from the text box to whatever it 

identifies.   
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DRAWING TEXTBOXES 
 

 
 
 
 
 
 
 
 
 
 
 
1.  Textboxes are used to label graphics and to add headings, page numbers, and text.  

Label your graphic after your graphic is otherwise finished.  When you set up your 
graphics page template, you set defaults for the lines and arrows.  If you set a 
default for the textbox for your template, it will affect your lines which will 
become No Line, No Fill.  Your graphic will be ruined! 

 
2.  Either braille your label in Braille2000 and copy it before pasting it into the textbox or 

type in ASCII directly into the textbox.  In ASCII, punctuation and numbers become 
the contractions such as ! equals "the" and "th" in braille; "4" equals "4" and the 
period; etc.  There's an ASCII cheat sheet in this handout. 

 
3.  Click on Textbox icon on Draw Toolbar and click close to where you want it.  Insert 

your braille or ASCII.  Turn your ASCII into Braille2000 PuffDots font, size 24. 
 
4.  Either right-click on the textbox to get Format/Textbox and click on the Size tab to 

set the correct measurements or drag it to the approximate size.  Do not click OK 
this first time because you also want to make the Color and Lines settings. 

 
5.  Click on Color and Line tab and choose No Fill, No Line under Line Color and Fill 

Color.  Now click OK.  Don't do this step if your textbox is within a textured area. 
 
6.  Click either Draw/Set AutoShape Defaults or right-click on textbox border and 

choose Format/Set AutoShape Default.  (Right-click gets you many of the same 
choices that clicking on Draw does.)  Now all your textboxes will have the No Fill, 
No Line default.  You still have to insert the braille and adjust the size.  Since you 
should save your Braille Graphic Page Template under a different name before 
doing anything else, this default will not affect your drawing. 

 

,textbox 

No Line, No Fill 
 

Usual Textbox 
Black Line, 
White Fill 

 

Within Texture 

,textbox 
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 DRAWING SHAPES 
FROM DRAW TASKBAR OR AUTOSHAPES MENUS 

 
 
 
 
 
 
 
 
 
 

 
Before you start your graphic, put in your headings, any necessary text, and page 
numbers.  For bar graphs, also put in the left-hand and bottom labels so you'll see how 
much room you have for the graphic.  You may have to copy some or all of the left-hand 
and bottom labels into textboxes later to better position them around the graphic. 
 
You can put shapes around other objects to form a border or frame.  They may also be 
used as squares, parts of other pictures, etc. 
 
1.  Click on the Rectangle or Oval icon and click in the approximate location where you 

want the rectangle or square.  OR 
1.  Click on AutoShapes and choose a Basic Shape, etc. and click in the location 

where you want the shape. 
 
2.  Click on the border of the shape. Now click on one of the small squares along the 

shape's sides and corners and "drag" the shape to the size you want.  OR 
2.  Right-click on the border and choose Format AutoShape, then the Size tab).  Make 

sure Lock Aspect Ratio is checked if you want the shape size to be proportional. 
  
3.  Use Line style icon to change the weight (width) of the lines, or right-click the line 

and use Format / AutoShape to fine tune its characteristics.   
 
4.  Use Draw / Rotate or Flip to rotate shapes around.  Some of the shapes have a 

small green circle or yellow diamond that may be dragged one way or another to 
change the angle, perspective, etc. of that shape. 

 
5.  Use Align or Distribute to line up groups of lines equal distance from each other. 
 
 
 
 
 
 

Grouped 
Duplicated lines 

Align middle or 
horizontally 

Align bottom 
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LINES 
 

Solid, dashed, and dotted lines are in order as easiest to follow.  Others, such as dot-
dash-dot, double, etc., are too confusing. 
 
Thin lines should be dashed instead of solid because dashed is easier to follow. 
 
0.75 pt dotted lines are good for inside grid lines. 
 
0.75 pt dotted lines are good for lead lines from labels to identified object. 
 
2 and 2.5 pt lines are good for braille graph border lines. 
 
3 and 3.5 pt lines are good for the line graph lines showing measurement. 
 
To Draw a Line 
1.  Click on the slanted Line icon on the Draw Toolbar to draw a straight line 
OR 
1.  Click on AutoShapes. 
2.  Click on Lines. 
3.  Choose any of the lines. 

a.  Line makes a "straight" line in any direction.  To make it truly straight, hold down 
the Shift key while dragging the cursor in any direction.  Let go of mouse button 
to stop drawing. 

b.  Curved makes curves (or straight if holding down the Shift while dragging the 
cursor).  Click your mouse button whenever changing direction even a little.  
Double-click the mouse button to stop drawing. 

c.  Freeform lines go every which way without clicking your mouse button.  Just 
drag the cursor in any direction.  Double-click the mouse button to stop drawing.  
You can fill a closed in freeform shape with texture or color. 

d.  Scribble lines go every which way.  Seldom used in braille graphics.  Let go of 
mouse button to stop drawing. 

 
 
 
 
 
 
 
 
 
 
                 Line                                 Curved                       Freeform                Scribble 

 
4.  Use Edit Points to change your line in any way. 
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ROTATE 
 

Click on shape or line to make it active.  Click on Draw / Rotate and choose which 
direction you want.  Free Rotate allows smaller increments of rotation.  Holding 

down the Shift key while using Free Rotate moves 15° increments. 
 

 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Free Rotate 

Basic 
AutoShape 

Triangle 

Basic 
Shape 

Cube 

Rotated by pulling or pushing yellow diamond. 

Rotated by pulling or pushing yellow diamond. 

Rotated by pulling or pushing green circles with 
or without Shift key. 
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EDIT POINTS 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
You cannot use Edit Points on any AutoShape.  You can use Edit Points on shapes 
you have drawn with lines. 
 
Depending on if you click on the lines or resulting points while the small black dots 
(points) mark your line or shape, you will get different menus related to either points or 
lines. 
 
You may add needed points and delete unnecessary points to change shapes. 
 
To delete multiple points quickly, hold down the Ctrl key while clicking each unwanted 
point.  Your cursor becomes an X.  Click to delete that point quickly. 
 
Close Curve will close any shape by joining both end points with a straight line. 
 
A blue line with a small square at each end shows up when you choose a type of point.  
Move each square to shape the area around that point—smooth, straight, and corner. 
 
Clicking on a line segment allows you to change from a straight line to a curved line and 
back again. 
 
Use Edit Points to place the ends of your line exactly making it longer or shorter as 
needed.  Drag the ends to where you need them. 



26 
 

EDIT POINT:  POINTS OR LINES MENUS 
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

EDIT POINT:  LINE SEGMENTS 
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FILL 
TEXTURED AND UNTEXTURED AREAS 

 
To make it easier for the blind person to locate different parts of a graphic, "texture" is 
sometimes added to a graphic.  Microsoft Word Fill Color calls it a pattern, not texture. 
 
All areas, textured or not, should be at least 1/4" square. 
 
All textures have to be identified in a key in a 1/2" by 1" rectangle.  Textures go first in 
the key. 
 
Same as in lines and points, the more important textured area should be the heavier, 
rougher texture.  It does not matter the type of texture if there's only one texture. 
 
It is best to leave 1/16" between the texture and the line around it to make it easier to 
feel the line.  This is especially good if you absolutely have to include texture in a pie 
chart or possibly a map. 
 
 
 
 
 
 
        1 & 2               3 & 4                                   5                                              6 
 
 
1.  Draw your shape or object or choose one of the AutoShapes. 
2.  Make it the correct size by right clicking on its border and choosing Format 

AutoShape or Format Object or whatever.  Then choose the Size tab.  Click Lock 
Aspect Ratio to keep the shape before changing the size.  Change the size. 

3.  Duplicate your shape. 
4.  Repeat Step 2.  Change the size to 2/10th smaller. (2 clicks down) 1.0" becomes .8". 
5.  Choose the Fill Color paint bucket icon on the Draw Toolbar.  Click on Fill Effects.  

Then Pattern (not Texture).   Choose a simple black or gray pattern.  OR 
5.  Choose Color and Lines on the Format AutoShape menu. 

A.  Fill Color:  Make sure black or one of the grays is chosen.  Click on Fill 
Effects.  Then Pattern (not Texture).  Choose a simple pattern.   Solids 
should always be gray instead of black because the Tactile Image Enhancer 
(TIE) regulates to the darkest color first.  A solid black area would likely make 
the braille text too light to feel.  The solid black sometimes "scabs" from 
absorbing so much heat.  Yuck! 

B.  Line Color:  Choose No Color, OK. 
6.  Use the Directional keys or "drag" the smaller shape into the larger.  See the white 

border around the texture? 
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GROUP 
 
Grouping items (shapes, lines, textboxes, etc.) together allows them to be moved, 
sized, etc. together in the same ratio, direction, etc.   
 
BE CAREFUL RESIZING GROUPED TEXTBOXES.  It can change the size of the 
braille font from size 29.  You can group them to move them or change the box 
lines some way.  Just do not resize them. 
 
         One method of grouping is to click on the Select Objects arrow on the  
         Draw Toolbar and draw a rectangle around all the objects. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Another method is by clicking on one item, then holding down the Shift key while 
clicking on all the other items you want grouped together.  This way works best if you 
are grouping all the arrows within a graphic and you do not want to group anything else 
with the arrows.  You can hunt and pick with this method. 
 
You have to use the Shift key method when you are drawing something with moving 
parts like a clock, thermometer, etc.  These use layers of groups.  The clock has the 
face with the tick marks, and numbers outside the face.  You group those together.  
Then you draw the hands that are individually grouped, then grouped together.  That 
way the hands may be moved on their own without accidentally moving something else 
on the clock.  See the clock instructions. 
 
WHEN YOU GROUP, GO TO THE FORMAT/AUTOSHAPE, OBJECT, WHATEVER, 
AND CLICK ON LAYOUT.  CHOOSE IN FRONT OF TEXT.  IT WILL USUALLY HAVE 
SWITCHED TO TIGHT.  THE "TIGHT" CHOICE CAUSES PROBLEMS LATER BY 
BUMPING OBJECTS ALL OVER THE PLACE. 
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LEAD LINES 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lead lines may be horizontal, vertical, or slanted.  They lead from the label to the 
item it's identifying. 

Lead lines usually go up to its item allowing one cell's blank space between the 
end of the lead line and the item. 

Lead lines sometimes have to go into the item it's identifying.  When that 
happens, allow 1/16" of blank space all around the lead line so that it may be followed 
correctly. 

 
1.  Click on the Line icon on the Draw Toolbar. 
2.  Hold down the Shift key and drag your cursor to draw the line.  The Shift key keeps 

the line straight. 
3.  To draw a lead line with the white space surrounding it into a shape: 
 a.  Click on the Line icon on the Draw Toolbar. 

b.  Hold down the Shift key and drag your cursor to draw the line where you want it.  
The Shift key keeps the line straight. 

c.  Right-click on the line and click on the Format AutoShape, then the Size tab.  
Make the line at least 3/4" long. 

d.  Hold down the Ctrl key and type the letter d to duplicate the line. 
e.  Use the Directional Arrows to move the second "spacer" line under or even with 

the first which will be the "lead line". 
f.  Right-click on the spacer line and click on the Size tab.  Make the line 10 weight. 
g.  Use the Line Color icon and make the wider spacer line white.  Pay attention 

where the white line is.  Try to keep the squares at each end so you can locate it. 
h.  Right-click on the wider spacer line or click Draw and choose Order.  Move the 

spacer line backward—not "To the back". 
i.  Use the Directional Arrows to move the spacer line behind the first. 
j.   The wider spacer line should still be active, so hold the Shift key down and click 

on the thinner lead line. 
k.  Group the lines together.  Now they may be moved into position between the 

label and into the shape. 

horizontal 

slant$ 

v]tical 
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LABELS 
 
 

Braille labels are always horizontal—never slanted or vertical.   They may take more 
than one line. 
 
Use No Fill, No Line on labels on a white background. 
 
Use a black line border and white fill on labels on a textured background.  There must 
be a minimum of 1/8" of white space (fill) around the label text out to the border. 
 
Whenever you can spell out the words within the boundary of what you are labeling, do 
so.  It makes for shorter keys and better understanding. 
 
If there is not enough room for the full label, use abbreviations and/or numbers and a 
key. 
 
If at all possible, place labels close to the right of whatever they label but no closer than 
1/8" (distance between 2 braille lines).  Do not put the label half on and half off the 
graphic. 
 
If the label cannot be placed close enough, a lead line should be used.  They should be 
at least 3/4" without any arrowheads no matter what is in print. 
 
Try to use different types of information lines in line graphs instead of crowding labels 
inside the graph to differentiate between lines.  Solid, dashed, and dotted are the best 
styles to use.  Others such as the dot-dash-dot, etc. are too confusing. 
 
Bar and Line graph measurement labels go down the left side and across the bottom of 
the graph even if they're on the right and top in print. 
 
Pie chart labels go on the outside of the chart. 
 
Clock numbers (labels) go on the outside of the circle clock near the 1/2" tick marks. 
 
Thermometer numbers go on the outside right of the rectangle tube.  Use 1/2" tick 
marks. 
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ADDING TEXT AND LABELS TO YOUR TACTILE GRAPHIC 
 
Inserting text before the graphic helps to determine how large your graphic can be.  You 
may find that all you can have on the page with the graphic is the title and the labels.    
You may have to put the explanatory text, questions, and the key, if needed, on other 
pages. 
 
1.  Open your Braille Graphic Template. 
2.  Save As the title of the book and name of your graphic as well as the print page 

number such as AH Louisiana Purchase Map p 02 for the Louisiana Purchase 
map on print page 02 in the textbook titled American History.  Make sure you save 
your template as a document file before you do anything at all to the template.  
You do not want to mess up your template. 

3.  Braille your text and copy it to the clipboard and onto your Word document.  In 
Braille2000, if you right-click the Copy button on the Control Panel, you can choose 
Lines.  This keeps the correct format and page numbers.   

You may also type in ASCII directly into the Word document.  Several ASCII files 
are on the CD you were given along with this handout.  Print out the Word ASCII 
files to have on hand as cheat sheets. 

4.  Make sure your page size and margins are set at 11.5 x 11" page size and 1" 
margins on the top, bottom, and left and .5" on the right. 

5.  Use Ctrl-a to highlight the entire page and change the font to BraillePuffDots size 24 
for regular ink printers and Braille29 for graphics embossed on a ViewPlus 
embosser.   

6.  Making sure all of the text is still highlighted, go to Format > Paragraph and change 
the Line Spacing to Exactly at 25 for text in BraillePuffDots font and to Exactly 29 
for text in Braille29 font. 

7.   If your last line or your braille page number is not on line 25, add blank lines until it 
is.  This makes it easier to insert your graphic correctly. 

8.  If you copied your label text into the Word document as well, all you need to do is to 
highlight each word or phrase individually and choose Insert > Textbox.  The 
highlighted text will be copied automatically into the textbox.   

9.  If the textbox is not the correct size, right-click on the border of the textbox and 
choose Format > Textbox.  Change the Layout to Behind Text, Color and Lines 
to No Fill, No Line, and Size to the appropriate size so that there's white empty 
space around the text.  Usually a one-line label needs to be .45 high to allow enough 
room. 

10.  If there's not enough room for the graphic and labels, delete all unnecessary braille 
text and put it on another page.  If there's anyway that the key can go on the same 
page as the graphic, put it there. 

11.  You may either insert a scanned image and trace it or draw the image manually. 
 

 



33 
 

KEYS 
 

The word Key should be started in cell 5 after a transcribers note symbol (dots 6, 1).  
The key should end with another transcriber's note symbol.  Skip a line after Key. 
 
Place the subdivision names such as Lakes, Routes, or whatever you've named the 
groups of items in your key, in cell 5 with a skipped line before but not after. 
 
Within the key, textures should be listed first, then lines and arrows, symbols, letter 
abbreviations, and finally number abbreviations within any subdivision of the key 
(Countries, Rivers, Towns, and Battles, etc.) 
 
Place textures inside rectangles in the key.  1/2" by 1" would be best size to give 
enough area for the fingers to feel.   They should begin in cell 1. 
 
Lines within the key should be 1" long. 
 
Symbols should be centered between braille cell 1 and 4. 
 
Except for graphs (bar graphs, line graphs, circle graphs, etc.), items are listed 
alphabetically according to the full word, not necessarily the abbreviation. 
 
For graphs, the key abbreviations are listed in the order they appear on the graph—left 
to right, top to bottom, clockwise from the top, etc. 
 
At least one of the letters in the abbreviation must have both upper-cell and lower-cell 
dots or the dot numbers must be given within parenthesis with number indicators and a 

comma between.  ca 7#ad1 #a7  ,cali=nia 

 
Try to use abbreviations that help to identify the item easier and try to use the same 
naming method for all items--first two letters of a name, use letter L along with first letter 
of name for all lakes, postal abbreviations for states, etc. 
 
Numbered keys are listed in numerical order. 



34 
 

 

=========== ,,graphic ,,title ======a#cb 

                                                                                                                 
           ,',key 
             
    ,walkways 

 

    ,wat] 

 

    ,riv] 

 

    ,trail 

 

    ,battle 

 

    ,town 

 

fl ,florida 

jx ,jacksonville 

#a ,sun"d clue ,fr%ip ,p>k,'  

 
This is not the full 11.5 x 11" graphic page.  It is 
only 11 x 8.5" landscape oriented.  This is why 
there is no braille page number at the bottom. 
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PART II 
Line Graphs 
Bar Graphs 
Histographs 

Venn Diagrams 
Circle Graphs or Pie Charts 

Spinners 
Clocks 

3-D Shapes 
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LINE GRAPH PRINT SAMPLE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Even though they are not in the print graph, we need to add grid lines inside the 

graph, tick marks on the outside borders, and move the legend/key to the top.  The 
graph may have to be changed in other ways so that it will fit on one page and/or be 
easier to understand.   

squ>e 
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LET'S MAKE A LINE GRAPH 
 

1.  Open your Braille Graphic Template and IMMEDIATELY Save As it under your book 
initials, graphic title, print page number. (AHIndianVillage P 08A for American History 
textbook Indian Village graphic on print page a8)  Otherwise you will mess up your 
graphic template.  You could also use P 08A Indian Village bar graph in the 
American History folder.. 

2.  Use ASCII or your braille program to braille the centered heading and page numbers 
in the correct location for the graphic and/or key page.  You can use Braille2000's 
Page Numbering command.  Also braille the baseline labels and side labels.  You 
may have to put each label inside a textbox later after you've drawn your graph, etc. 
so that it may be moved in small increments to fit better.  Experience will tell you. 

3.  Highlight the entire braille page by holding down the Ctrl key while pressing the a 
key.  (Ctrl-a = Copy All) 

4.  Right click the Copy button on the Braille2000's Control Panel and choose Lines. 
5.  Open your Tiger Graphic Page 11.5 x 11 template or file.  You may have to use 

New. 
6.  Paste the braille into the Word file by pressing Ctrl-v or going to Home tab, then 

Paste.  The braille may be ASCII or braille dots.   
7.  Choose Braille29 size 29 for ViewPlus embossers as the font. 
8.  Space out the braille cells and lines by going to Format, then Paragraph. 
9.  Change Line Spacing to Exactly at 28 for the Braille29 font.  Everything should be 

in correct place. 
10.  If you do not have the rulers and grid lines on your screen, add at least the rulers.   
11.  Now you can add the Grid Lines if you like them.   
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LINE GRAPH BRAILLE TEXT 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

No room for the graph with the 
text and transcriber's note. 
 
1,500,000,000 will be 1,500 
and 1960 will be 60 without 
the number sign on the graph. 

Neither China nor India's 
lines go as high as the top 
number of 2,000,000,000  
so it was deleted to make 
more room for the graph.. 
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BRAILLE TEXT PASTED INTO WORD FILE 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You do not have to paste both pages into Word unless you have to put your key on the 
previous page and the key needs textures, lines, etc.  If your key only needs words,  
abbreviations or numbers, just braille it within your braille text file.   
 
Remember to start and end your key with a transcriber's note indicator. 
 
Double-check to make sure your font is Braille29 font size 29.)   Your page should be 
11.5 x 11" (portrait orientation) with margins of top of 0.6, left of 1.0 and bottom and 
right margins of 0.5" . Make sure your Line Spacing is Exactly 28.) 
 
SAVE YOUR WORK!  Make sure all your braille text and page numbers are in the 
correct place.  SAVE YOUR WORK AGAIN!  MAKE A BACKUP! 

 



40 
 

Add Grid Lines 

 
1.  Make sure you have your ruler across the top and sides of your screen.  To add the 

ruler, go to View and click Ruler.   You may have to do it twice to get both top and 
side rulers. 

2.  Draw a 1/2" vertical line (above first number, abbreviation, etc. across the bottom).  
Make it 2.25 (2-1/4) pt.  Tick marks have to be 1/2" long with 1/4" on each side of 
the horizontal line.   Grid lines are only .75 pt and dotted so tick marks overlay. 

 
 
 
 
4.  Draw a horizontal line from the middle of the vertical line across the page 

approximately the width of your page.  It can be enlarged or reduced later. 
 
 
 
 
5.  Select the vertical line and duplicate it by holding down the Ctrl key and pressing the 

letter d key as many times as you need tick marks.  Make sure to count the first and 
last tick marks.  

 
 
 
 
 
 
 
 
 
 
 
6.  Select the horizontal and all of the vertical lines.  Go to Draw / Align and Distribute.  

Choose Align middle.  Then move the vertical line farthest to the right close to the 
width of grid you need (above the last number, etc. to the right).  SAVE YOUR 
WORK! 

 
 
 
 
 
 
 
7.  Select all the vertical lines without going to the end of the horizontal line.  This way 

the vertical lines will equally distribute the lines the distance from the first to the last 
vertical line and not to the end of the horizontal line.   
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fj gj hj ij jj aj bj cj dj ej  

 
8.  Click on Draw on the Draw toolbar and choose Align or Distribute.  Choose Align 

horizontally.   Now your lines should be distributed equally horizontally across the 
horizontal line as below. 

 
 
 
 
 
9.  Right-Click on the horizontal line and choose Size.  Change the width so that both 

ends touch the first and last vertical lines.  If you need a tick mark on the bottom left 
of the graph, allow for it or add a 1/4" line to the left.  Look at the top ruler to see. 

 
 
 
 
10.  Group the lines together.  There are two methods.  Sometimes one works better 

than the other.  Use Method B when you only want to group certain lines, etc.  This 
makes it easier to move and modify the group of lines. 

 
Method A: 

A.  Click on the Select Objects white arrow next to "Draw" on the left side of the 
Draw Toolbar.  

B.  Hold down the Left Mouse button and drag the line around all of the lines that 
you want to be grouped.  You will notice that there are small squares at the 
ends of every line. 

C.  Click on Draw on the Draw Toolbar and then Group to group all the lines 
together.   You can tell the group of lines is grouped by noticing the small 
squares at each corner and middle of each side of the grouped area.   

 
Method B:   
A.  Click on one of the lines.   
B.  Hold down the Shift key while clicking all the other lines you want to group 

with the Left-Mouse Button.  All the lines have small squares at the ends. 
C.  Click on Draw on the Draw Toolbar and then Group to group all the lines 

together.   You can tell the group of lines is grouped by noticing the small 
squares at each corner and middle of each side of the grouped area.   

11.  After you grouped your lines together, move it so that the vertical lines line up 
above the year abbreviations.  Don't put anything under the first tick mark in this 
instance.  Line up the horizontal line with the middle dots of the braille cell in 0.  
SAVE YOUR WORK! 

   
 

#j 
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,9DIA ,' 

 
 
12.  Draw a .5" line and line it up with the end of the grouped tick mark line.  Move that 

line up next to the middle dots for 500 (#ejj).  Duplicate that line with Ctrl-d and 
move them up next to 1,000 and 1,500 so that they serve as side tick marks. 

 
13.  Ungroup the bottom tick mark line and click off to the side in the margins to nothing 

is selected anymore.  Now right click on the left-hand tick mark that is above nothing. 
 
14.  Choose Format AutoShape / Size.  Change the height to 5.7".  Don't panic if the 

line goes off the bottom of the braille page.  It can be moved up easily with the 
Directional Up arrow until the bottom of that vertical line has only 1/4" (.25") of the 
line below its horizontal line.  You may have to fine tune the location by using the 
Ctrl key with the Directional arrows.  Notice that there's a little bit showing above 
the top horizontal tick mark beside 1,500.  That's fine.  Now you have your side and 
bottom of your graph.  SAVE! 

 
15.  The graph needs to be closed in even though it is not in print.  Duplicate the bottom 

line enough times to be able to put one each over each of the side tick marks near 
remaining side tick marks.  Now you have 4 horizontal lines on the graph. 

 
16.  The braille graph needs inner grid lines even if the print graph doesn't have any.  

Click on the 500 line, then hold down the Shift key and click on the 1,000 line.  The 
two should all have the small squares at their ends.  Change the lines to 1.5 pt and 
dotted by using the Line Style and Dash Style icons on the Draw toolbar. 

 
17.  Do the same with the vertical lines so that you end up with thinner dotted grid lines 

and darker tick marks and border.  When you duplicate so many lines, they tend to 
get placed a little off.  Select the vertical dotted grid lines with the right border line 
and choose Align bottom.  Group everything together and SAVE.   

 
18.  When the print graph has no inner grid lines, you may need to draw all or part of 

them yourself manually on the print graph using a right-angle square, etc.  This 
helps you to place the braille measurement lines and dots correctly.   

 
19.  Click on the Oval on the Draw toolbar and change the circle's size to .25".  Make it 

3 pts.  Move it between the 2nd and 3rd braille cell of the line "China" is on in the 
key.  Draw an 1" line vertically through the middle of it.  Group the circle and line 
together.  Duplicate the shape and move this one on the line with "India" in the key.    
Ungroup the China shape.  Click on the circle and Fill it with the lightest gray color.  
Regroup the shape.  Skip a line between. 

 

                           ,*9A 
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20.  Draw another filled circle.  Duplicate it and move the other circles where China's 
circles should be on the grid lines.  Duplicate an extra circle and change the fill color 
to white.  Duplicate the white circle and place the other circles where India's circles 
should be on the grid lines.  SAVE. 

 
21.  Start a line at the first of China's filled circles and end it close to the last of the filled 

circles.  Right-click on the line and choose Edit Points.  Drag each end of the line 
into the middle of the end filled circles.  Now drag the line into each of the other filled 
circles.  It may not look exactly like the print, but it will be close.  The proportions of 
the graph may be slightly different than the print graph. 

 
22.  Repeat with India's white circles.  Group and SAVE! 
 
23.  You will need to delete the year abbreviations because they do not fit correctly 

under the bottom tick marks.  Insert a Text Box and type fj and highlight the two 
letters and change the font to Braille29 size 29.)  Right click the border of the text 
box and change the height to .45" and make the width .75".  Duplicate enough of the 
textboxes to match the tick marks.  Move them into place and change each one to 
the correct numbers.  Remember that braille numbers are really letters with the 
number sign in front but the transcriber's note said we would not be using the 
number sign.  fj is 60, gj is 70, and so on.  SAVE! 
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BAR GRAPHSS 
 
 

BAR GRAPH PRINT SAMPLES 
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If slanted lines on the left vertical border 
indicate missing measurements and tick marks, 
include the slanted lines. 
 

DRAWING A DOUBLE BAR GRAPH 

 
Each of the bars on the bar graph should be 1/2" wide.    Try to separate each bar at 
least 1/4" apart unless the bars are connected in print. 
 
If you have more than one graph with basically the same labels and number of lines, 
complete one blank graph and save it to use later with other graphs.  Just copy and 
paste it into place.  Just change the title, etc. 
 
Some bar graphs have vertical bars and others have horizontal bars.  Make the braille 
graphs the same direction as the print unless there is not enough room on the braille 
page. 
 
As long as you add a transcriber's note regarding the change in orientation, the graph 
may be turned from vertical to horizontal, etc. in order to get the entire graph on one 
page. Lowest number should be on left on bottom. 
 
Some graphs are so long that they have to be divided between braille pages.  Make 
sure to add a transcriber's note regarding the change and label partial graphs. 
 
Labels on graphs may be abbreviated and used with a key. 
 
Labels may be staggered to make them fit horizontally. 
 
 
 
 
 
 
 
 
 
The vertical title of the left-side labels should be moved to the line above the top label.  
Remember that labels cannot be brailled vertically. 
 
You usually do not need both vertical and horizontal grid lines in a bar graph.  Vertical 
bars require horizontal lines while horizontal bars require vertical lines.   
 
You can delete tick marks and grid lines from either the top or the bottom if none of the 
bars reach those top marks or if all the bars are higher than the second from the bottom 
tick mark and grid line.  Only do this if you need the room to fit the rest of the graph. 
 
 

ab ef ij mn qr uv 

cd gh kl op st wx 



46 
 

DOUBLE BAR GRAPH 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  After you braille (or type and translate) the text and paste it into your braille graphic 

template page, Save As another name.   
 

2.  Draw a horizontal line from about .25" from the middle dots of #he (#85) to the 

right a little way past #B3JJ  (2:00) so it looks the length of the print line.  Make 

it  
 
3.  Duplicate the line so that you have enough grid lines to match all of the tick marks.  

Change all of the grid lines, except the top and bottom lines, to .75 pt and dotted.  
Make the top and bottom lines 2.25 pt and solid. 

 
4.  Use the Select Objects arrow on the Draw toolbar to select all of the lines. 
 
5.  Click on Draw / Align or Distribute and choose Align Left.  Move the top line next 

to the middle dots of #85 and the bottom to the middle dots of #40.. 
 
6.  Select all of the lines again.  Now Align Vertically. 
 
7.  Draw a vertical line from .25" from the left end of the #40 grid line to the #85 grid line.  

Match its size to the top and bottom lines.  Duplicate it and move it to the right 
margin.   If you need to shorten the vertical lines, do so before moving it.  SAVE! 
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8.  Click on the Rectangle icon on the Draw toolbar and draw a 1/2" wide bar above 
one of the times.  You will change the height later.  Duplicate it enough times to 
make all the bars on the graph.  You do not need any tick marks. 

 
9.  Drag the first bar to the correct height.  If it's still not quite correct, right click on the 

bar, click Format AutoShape / Size, and increase or decrease the height as 
needed.  You can change the size by .1" or .01". 

 
 
 
 
 
 
 
 
 
                  .5                     .51                 .6                 1.0                1.05 
10.  Move the pairs of bars next to each other and center the pairs over their time.  You 

may have to move the times by spacing or insert the times into textboxes that can be 
more easily moved. 

 
11.  Fill in the shade bars with whatever texture(s) you chose for your key.  Make sure 

you put your .5 x 1.0" rectangles in your key.  One of the bars can be white and the 
other shaded or a light gray.  Shaded is better.   

 
12.  Group the shade and the bar together, then group the shaded bar and the white bar 

next to it together.  Group the entire graph together. 
 
13.  SAVE YOUR WORK!  BACK IT UP! 
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PICTOGRAPHS 
 

Pictographs use pictures and/or parts of pictures to represent  amounts of data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pictographs for students in K-3 grades must be a tactile graphic.  Use shapes if the 
actual picture cannot be reproduced discernibly.  The student won't be able to tell the 
difference between apples and oranges, etc.  You can also use the full braille cell. 
 
Simple pictographs (only for whole or half items) for students in grades 4 and above can 
be brailled instead of using tactile graphics.  The full cell would be one and dots 123 
would be half. 
 
A transcriber's note is needed to explain that a substitution has been made. 
 
Leave one space between the row heading and the first item. 
 
If the graph shows boxing lines, you may use braille boxing lines (top = 2356 and 
bottom = 1245). 
 
The key of a pictograph (usually on the bottom in print) should be above the graph. 
 
Use number signs in pictographs. 
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COMPLETED PICTOGRAPH 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

777777777777777777777777777 
,New ,York ,C;y, 
,New ,York         =======l 
333333333333333333333333333 
,Los Angeles, 
,Cali=nia          ===l 
333333333333333333333333333 
,H\ston, 
,Texas             =l 
ggggggggggggggggggggggggggg 
 



50 
 

VENN DIAGRAMS 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Give the two (or more) circles different line styles—solid and dashed or solid and dotted. 
 
Center the labels inside the overlapping circles.   If the labels are a little too large to fit, 
try stretching the circles into ovals to make more room.  If the labels are still too large to 
fit, use abbreviations and a key. 
 
If a rectangle surrounds the circles in print, include it in your graphic. 
 
Use the numeric indicator if numbers are listed. 
 
1.  Draw a circle using AutoShapes or the Oval icon on the Draw Taskbar. 
2.  No Fill and a black line between 2 and 2.5 pt 
3.  Ctrl-d to duplicate the circle. 
4.  Match the print with whichever type of line to use for the ovals.  Change the line to a 

dashed or dotted line using the Dashed Style icon on the Draw Taskbar or right 
click on the second circle to get Format, then Color and Lines and change the 
width to 2-2.5 pt. 

5.  Overlap one circle with the other and group them by the Select Object arrow, then 
Group. 

6.  Insert textboxes for the inside information and center the information within each 
circle.  Use No Fill, No Line for the textboxes. 

7.  Group the textboxes together.  Now group everything. 
 
 
 
 
 

DOGS 
 

Bark 
 
 

CATS 
 

Meow 
  

BOTH 
 

Eat 
Sleep 
Poop 
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Notice how much bigger the Venn diagram needs to be because of the braille font.  
These went from 2.81" in diameter each to 4.0" in diameter each just to make room. 
 
Also notice how much blank space is between the text and the lines. 
 
 
   

,,bo? 

 

,eat 

,sleep 

,poop 

,,dogs 

 

,b>k 

,,cats 

 

,me{ 
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CIRCLE GRAPH OR PIE CHART PRINT SAMPLE 
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CIRCLE GRAPH OR PIE CHART INFORMATION 
 

The outside circle line should be a different kind of line than the inside lines of a pie 
chart—solid outside and possibly dotted inside. 
 
If inside lines are too close together in the center of the chart to distinguish, stop them 
just short of the center so everything is not packed together in one lump. 
 
The circle graph may be turned some to make it easier to label the sections. 
 
Labels go outside the circle. 
 
Labels that are too long to go along the circle should be changed to abbreviations and 
added to a key. 
 
Use the numeric indicator with numbers. 
 
Do not use textures within a pie chart or circle graph unless they are there for a specific 
reason.  You can mention the color of a section within the key description or label. 
 
Unless it is necessary to know the exact size of the pie chart's sections, you can 
estimate where the inner lines go.  The measurement percentages are given in print a 
lot of times. 
 
If the pie or circle chart is simply divided into halves, fourths, or eighths, you can draw 
temporary lines from the shape's border small squares to use as a guide.   
 
You can either scan and trace the print pie chart or enlarge the print copy enough to use 
a protractor to measure the angles to reproduce the inner lines correctly.   
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 SCANNED PIE CHART TRACED IN RED 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ORIGINAL SCANNED IMAGE DELETED 
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DRAWING THE PIE CHART 
 

1.  Open your graphics file with the braille text. 
2.  Click on either the Oval or click on AutoShapes > Oval on the Draw Toolbar. 
3.  Click where you want the circle on your graphics page.  It probably won't be in the 

exact place you want it, but you can move it using the Ctrl key and the Directional 
Arrows. 

4.  Either hold down the Shift key and drag the circle to the size you want or right-click 
on the circle's border and choose Format  > Size to choose the correct size.   Make 
sure you click  Lock Aspect Ratio before changing the size. 

5.  Right-click on the circle's border and choose Format > Colors and Lines to choose 
No Fill, Black Line.  Make the line 2.5-3 pts width and solid. 

6.  Click on the circle so that the small blank squares appear.  Use these squares as 
guides in dividing the circle into halves, quarters, and eighths with dashed or red 
lines.  They can extend past the circle's borders as they will be deleted later. 

7.  If the student does not have to measure the angles, try to get as close as possible.  
It's not necessary to get it exactly unless measured. 

8.  Use  black 2.5 dotted lines for the inner dividing lines. 
9.  Do not use Fill for pie charts.   
10.  Labels go outside the pie chart to make it easier to fill the dividing lines and space 

of each section of the pie chart. 
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           ,FRUITS ,SOLD AT        #ci         

,O',H5RY'S ,FRUIT ,/& 

,JULY #A 6,JULY #G 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                      

APRICOTS 

GRAPES 

P1*ES 

WAT]MELON 

#ab plums     

This is only an 8.5 x 
11" page orientated 
as landscape 
instead of 11.5 x 11" 
braille page. 
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DRAWING SPINNERS 
Spinners are used for games or probabilities.  They are drawn the same way as pie 
charts are except for the added spinner inside.  Most have to be enlarged to make it 
easier to feel the sections. 
 
Outside and inside lines must be different.  The arrow spinner is a simple arrow and a 
different line than the other lines. 
 
Do not use texture on a spinner.  If the circle sections are different colors, name the 
color as a label placed 1/8" outside the circle.  If the labels are too long, use 
abbreviations and a key. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can make a spinner that will turn correctly around the board.  A normal arrow or line 
will spin from its center, not from the end without the arrowhead.  If you duplicate the 
arrow and put them end-to-end, they will spin where they meet. 
 
 
 
 
 
 

#a  

blue 

#b  

r$ 

#c  

yell[ 

#d  

gre5 
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A print spinner only has one arrowhead.  How do you get it to spin where it should? 
 
1.  Draw an arrow and change the size and style of arrowhead to match the one below. 
 
2.  Duplicate it. 
 
3.  Rotate or Flip the copy Horizontally and move it so that the plain ends meet 

exactly. 
 
 
 
                        No quite  Exactly 
 
 
This manual shows the second arrow dotted so that you can see what's happening.  
The gray arrow should be No Line.  It will also show the correct spinner. 
 
 
 
 
4.  Change the second arrow's color to No Line using the Line Color icon on the Draw 

toolbar.  It will still be selected, so hold down your Shift key and click the black 
arrow.  

 
5.  Group the arrows by clicking on Draw / Group.  Notice the small squares border the 

"invisible" half too. 
 
6.  Center the arrow onto the spinner board.  Where the inner lines meet is the center of 

the circle. 
 
7.  Click on the black arrow.  Click on Draw / Rotate / Free Rotate.  Green circles will 

appear on the arrow's length.  Turn the arrow to the correct position. 
 
8.  Group and copy the spinner board and spinner arrow.  Copy and paste it into 

another file in case you need another spinner in the future.  SAVE BOTH!  Just 
ungroup to rotate the spinner. 
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ANALOG CLOCKS INFORMATION 
 

Depending on the student's grade and skill, you can put either 1, 2, or 4 clocks on a 
braille page.  Just to start, use a single larger clock so that the parts are easier to find. 
 
If showing 2 clocks, draw them one under the other.  4 clocks are shown 2 x 2. 
 
Do not use the number sign on clocks. 
 
The outside circle of the clock face should be a different line than the tick marks for the 
hours.   
 
Do not show the minute tick marks unless needed to answer questions.  If needed, the 
clock has to be larger to differentiate between the tick marks. 
 
Tick marks straddle the circumference of the clock no less than 3/16" and no more than 
1/4" on either side of the circle. 
 
The numbers go on the outside of the circle about 1/8" away from the tick marks. 
 
The hour hand and the minute hand should be different texture and length.  The hour 
hand should be dotted or dashed and have an arrowhead.  The minute hand should be 
a smooth line. 
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DRAWING CLOCKS 
 

1.  Draw a dotted circle about 4" in diameter.  (The ones below are smaller so they fit.)  
Use 2 pt size. 

 
2.  Draw a thin dotted line from the top to the bottom small square.  Now draw another 

dotted line from the left to the right small square.  Group the two dotted lines. 
 
3.  Duplicate the dotted lines.  Match the copy over the top of the first line and while it is 

still selected, click on Draw / Rotate or Flip / Free Rotate and rotate the second 
group of dotted lines about 1/3 way around the axis so that it looks like the circle 
below on the left.   

 
4.  Repeat the steps so that the dotted lines look like the circle below on the right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.  Draw a 1/2"  long tick mark 2.5 pt over each line across the circumference of the 

circle.  Draw the 3, 6, 9, and 12 o'clock tick marks first.   
 
6.  Duplicate the 6:00 tick mark.  Click on Draw / Rotate or Flip / Free Rotate.  Rotate 

the copy to fit properly over either the 7:00 or 5:00 line.  Do the opposite tick mark by 
duplicating and moving.  Repeat until all the tick marks are in place.  Select the tick 
marks using the Shift key and click method and group just them without the rest of 
the clock.  SAVE! 

 
7.  Remove the inner dotted lines.   Select everything using the Select Object method 

and Group.  SAVE. 
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8.  You will need to use text boxes to add the numbers to the outside of the clock.  
Remember that you do not use the number sign on clocks. 

 
9.  Use the Shift key and click method to select and Group the numbers together. 
 
10.  Use the Select Objects method to select and Group the numbers and clock face 

together. 
 
11.  Add a light gray .25" circle to the middle of the clock face. 
 
 
 
 
 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12.  You build the clock hands like you did the spinner arrow.  Each one is grouped 

separately so that they may be rotated individually. 
 
13.   The hour hand should be dotted or dashed with an arrowhead.  Draw an 1" long 

arrow with a dashed or dotted shaft.  Use the larger arrowhead (bottom center 
choice) and 3.5 pt.   Duplicate it.  Change the copy to No Line and Group it with the 
other arrow.  Move it so that it is facing 3:00. 

 
  
 

c 

ab 

f 

a 

b 

d 

e g 

h 

i 

aj 

aa 
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14.  The minute hand should be smooth with no arrowhead.  Draw a 1" line at 3.5 pt.  
Duplicate it.  Change the copy to No Line and Group it with the other line.  Rotate it 
so that it is pointing to 6:00.   

 
 
 
15.  Click on the little gray circle in the middle of the clock face.  Click on Draw / Order / 

Bring to Front so that the circle is over the lines.   
 
16.  Click on the smooth minute hand.  Click on Draw / Rotate or Flip / Free Rotate 

and carefully rotate the minute hand around to where you want. 
 
17.  Click on the dashed or dotted hour hand.  Click on Draw / Rotate or Flip / Free 

Rotate and carefully rotate the hour hand around to where you want. 
 
18.  SAVE!  Now SAVE AS under a different filename such as ClockFace4inch.  

Whenever you need another clock of that size, open that file and copy and paste it 
into the file where a clock is needed.   
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Triangle Draw white line 
same length as 
triangle but 2.25-
3 pt wide. 

Same White Line 
Moved Up to 
Hide Black Line 
 

Draw curved line. 
Duplicate it.   
Change to dotted & 
flip.   
Move lines up. 

Group.  Now cone. 

SHOWING INSIDE LINES OF 3-D SHAPES 
 
 
 
 
 
 
 
 
 
 

AutoShapeDuplicate CylinderOverlap 
CylinderFlipped Vertically   Group 
Change to 2.25 ptChange to DottedSAVE 

 
 
 
 
 
 
 
 
 
 
 
 CubeDuplicate Cube 
 Draw Lines from corners to meet. 
 Change to Dotted Lines 
 Group Dotted Lines, then Cube and Lines 
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REUSE GRAPHICS IN THIS FILE 
 
You should get a CD with this handout.  The CD will hold both the Word and PDF 
versions of this workshop, both Parts I and II.  Part I contains information and 
instructions about computer graphics.   
 
The CD also contains extra basic graphics that are available for use any time you want. 

Please reuse any of the graphics you find in the Word file on the CD that came with this 
handout or any of the other graphics on your CD.  Open your Word file and select the 
graphic.  Use Ctrl c to copy it and Ctrl v to paste it into your new file (or Edit / Copy or 
Paste). 
 

THE END 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


